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Exercise 1: Introduction to ArcGIS 

 
Description:  This exercise introduces you to ArcCatalog and ArcMap. You will prepare a folder 
structure to store the data files and map products. The relationship between ArcGIS and Excel is 
demonstrated so that you can create maps in ArcGIS.  

 
Note: It is highly recommended that you take notes while you do the lab to track what you have done. 
 
Objectives: : 

○ Managing data in ArcCatalog  
○ Getting familiar with the ArcMap interface  
○ Working with attribute tables: add a field, using the field calculator, joining tables  
○ Creating new geographic data from a spreadsheet.  
○ Using symbology and labels. 
○ Create a layout  
○ Viewing metadata  

 
Skills:  Data management and organization; working with spreadsheets; visualization and cartography 
 
Data:   Boundary data for this exercise are from the US Department of State, Office of the 
Geographer. Visit this site to read more about the metadata:  
https://data.hdx.rwlabs.org/dataset/lsib-polygons-africa-and-americas-simplified.  Population data 
are from the UN Department of Economic and Social Affairs, Population Division.  Visit this site to 
read the metadata:  http://esa.un.org/unpd/wup/CD-
ROM/WUP2014_DOCUMENTATION%5CWUP2014_DESCRIPTION_CD.pdf 
Boundary shapefiles: 

-AfricaAmericas_LSIB_Polygons_Simplified_2015Jan23_USG.shp 
-EurasiaOceania_LSIB_Polygons_Simplified_2015Jan23_USG.shp  
-Global_LSIB_Lines_Simplified_2015Jan23_USG.shp 

UN Population Data:  WUP2014-F22-Cities_Over_300K_Annual.xls 
 

 
PART 1: ArcCatalog, the best practice for data management 

 
1. Start ArcCatalog from the Start Menu->ArcGIS. You will need to map or connect to the folder 

where the data are located. 
o In ArcCatalog, click on File/Connect to Folder or click on the ‘Connect to Folder’ icon. 

 
o Navigate to the location of the workshop folder, which is displayed at the front of the 

classroom. Click on the folder, and then click OK.  
 

2. To the right of the Catalog Tree, in the Data Window, there are a few tabs through which you can 
explore your data: Contents, Preview and Description. 

o The Contents tab displays the content of the folder with icons symbolizing the type of 
data, such as point, line, polygon, or raster.  

https://data.hdx.rwlabs.org/dataset/lsib-polygons-africa-and-americas-simplified
http://esa.un.org/unpd/wup/CD-ROM/WUP2014_DOCUMENTATION%5CWUP2014_DESCRIPTION_CD.pdf
http://esa.un.org/unpd/wup/CD-ROM/WUP2014_DOCUMENTATION%5CWUP2014_DESCRIPTION_CD.pdf
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Insider Tip: An ArcMap 

document is called an 

‘MXD’ for short, because 

the file extension is .mxd 

o The Preview tab shows the geographic representation of the data. 
o The Description tab displays descriptive information (metadata) about the data, if it 

has been properly created.  
 
NOTE: When copying and moving data, ALWAYS do this in ArcCatalog. Do not copy/delete/rename 

data using Windows Explorer. When using ArcCatalog, you automatically capture all the data files 

associated with each shapefile. If you copy shapefiles from Windows Explorer, you must be sure to 

copy all files that belong with a shapefile (.shx, .shp, .dbf, .prj, .xml) or your data will be unreadable. 

 

PART 2: Getting familiar with ArcMap 
 
1. Start ArcMap by clicking on the ArcMap button. A dialogue appears providing the 

option to open a new map, a template, or an existing map.  

▪ A Blank Map option is used if you are starting a new map.  
▪ A Template is used if you want to use a layout that has already been created. 
▪ The Existing Map option is used if you want to open a map file that has been 

previously created in ArcMap.  
 

o Since we are making a new map and not using a template, select Blank Map.  
 

2. Table of Contents and Data Frames. When you first start a blank 
map, ArcMap automatically creates a working area, or Data 
Frame, called Layers in your Table of Contents. You can also 
create new Data Frames and have several Data Frames in a 
single ArcMap Map Document. Each data frame can focus on a 
different geographical area, or thematic area. Having multiple 
data frames will allow you to make multiple maps in a single Map Document. However, too many 
data frames can slow down the software, so use them wisely! We will cover adding new data 
frames later in the lab. 
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Overview of ArcMap Interface. 
 
IMPORTANT NOTE: Each data frame has its own properties, one of the most important of which is 
projection. The projection for a data frame will default to the projection of the first layer added to the 
data frame. All layers thereafter added to that data frame will be on-the-fly‐projected to the same 
coordinate system as the data frame. Note that this is for display purposes only, and this does not change 
the permanent coordinate system of the newly added layer.  
 

o To set the Data Frame properties right click on Layers and select Properties to open the 

Data Frame Properties window. Various tabs control the properties for the data frame. 

Select some of the other tabs to see the different options. We will explore these in depth 

at another time. For now, close the window when you are through with the tabs. 
 

3. Navigation and Data View. Now we are going to explore some geographic data using 
ArcMap.  

▪ Use the Add Data button  to add the data for this exercise.  
▪ Navigate to the Data folder and select the 

AfricaAmericas_LSIB_Polygons_Simplified_2015Jan23_USG.shp shapefile.  
▪ Click the Add button to add the layer.  

 
o Important concept: We have just created a layer in ArcMap. Each layer references a 

dataset and specifies how that dataset is portrayed using symbols and text labels. It is 
important to note that the MXD does not house a shapefile. The layer is POINTING to a 
shapefile.  
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o Let’s explore this new dataset by navigating the map in the Data View.  Data View is 
used to display, query, edit, explore and analyze data. 

 
o Use the navigation bar to zoom in, zoom out, and pan around your map. Use the 

magnifying glass to zoom in and out, and use the white glove to pan. To quit using the 
navigation tools, click the black arrow. 
 

 
 

o Add two additional datasets:  
▪ EurasiaOceania_LSIB_Polygons_Simplified_2015Jan23_USG.shp  
▪ Global_LSIB_Lines_Simplified_2015Jan23_USG.shp  
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Insider Tip: You can change the order of the data layers in the Data Frame by clicking and 
dragging a data layer up or down. ArcGIS draws from the bottom up, meaning that the layers 

on top in the table of contents are shown above the layers on bottom in the data view. 
 

In general, data layers should be organized with points at the top, followed by lines and then 
polygons on the bottom of the list.  

 
ArcMap will default to this drawing order when adding data to the map. 

Insider Tip: You can also 

simply double click on 

either a Data Frame or a 

Data Layer to get to the 

Properties dialog. 

 
o Explore their geography in the data view.  

 
o Let’s rename our layers so that we can refer to them more easily. You will find that 

there are multiple ways to accomplish just about anything in ArcMap. You can 
rename a layer at least 3 different ways: 

▪ Double click to access Properties and change the name in the General tab, or 
▪ Click once on the layer, wait a moment, and click again, then type in the new 

name and hit enter, or 
▪ Click on a layer, hit F2, type a new name, and hit enter.  
NOTE:  These techniques are renaming the layers in your MXD, not the actual 
shapefile names.  

o Use one of these techniques to rename the layers as follows: 
▪ EurasiaOceania_LSIB_Polygons_Simplified_2015Jan23_USG 

● Change to LSIB Eurasia and Oceania 
▪ AfricaAmericas_LSIB_Polygons_Simplified_2015Jan23_USG 

● Change to LSIB Africa and Americas 
▪ Global_LSIB_Lines_Simplified_2015Jan23_USG 

● Change to  LSIB Lines 
 
 

4. Data Layer properties. Just as the Data Frame has 
properties, each layer in the Table of Contents also has 
properties. To view the properties of a data layer, right click 
on the layer name and select Properties to open the Layer 
Properties window. You can view and modify the display 
properties of the layer including symbology and labeling 
options. Some of the most important things you can do: 

 

o General tab allows 
changing the name of the 
layer, adding description and 
credits, and making the layer 
invisible at a certain scale. This 
helps declutter your map at 
different scales. 
o Source tab allows viewing 
the metadata and editing the 
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data source of the layer.  
o Selection tab allows customizing selection symbology.  
o Display tab allows changing transparency of the layer and the default attribute field that 
shows when you identify on a feature.  
o Symbology tab allows customizing and importing symbology of the layer via 
Features, Categories, Quantities, Charts, and Multiple Attributes.  
o Fields tab allows customizing the display of attribute data, which is useful when 
you have many attributes but are not interested in seeing all of them all the time.  
o Definition Query tab allows to write scripts to query the data via Query Builder. 
o Labels tab allows displaying, changing symbology, and defining placement, scale, and style of 
the labels.  
o Join & Relates tab allows joining and relating various datasets.  
o Time allows animation of data with time attributes  
o HTML Popup tab allows showing the content of the layer using HTML Popup tool. 

Close the Layer Properties dialog. 

 
5. Attribute Data. How do you know what you are looking at in the Data View? There are 

multiple ways to get more information about the geographic data you are viewing. We 
will explore the attribute information for your geographic data.  
 

o An integral part of each shapefile is a .dbf  file, or database file. This contains the 
attribute information about your data. It can be very robust or very minimal, 
depending on the data source and purpose of the data. Attributes should be 
thoroughly defined in the dataset’s metadata (more about metadata later) 

o Attribute tables contain a row (record) for each feature in the layer and a 
column (field) for each attribute.  

▪ A Feature is a single geographic feature, such as a single point, line or 
polygon. 

▪ An Attribute is a characteristic of that geographic feature. For example, 
an attribute of a city point may be the population or the year it was 
founded. 
 

o Attribute tables. Right click on the Africa and Americas LSIB layer and select Open Attribute 
Table. There are attribute values for each country, because each country has its own polygon. 
Scroll across the table and examine the attributes. When a record is highlighted in the 
attribute table (by clicking on the blank square to the left of each record) the corresponding 
feature is highlighted on the map. 
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o Identify tool. If you are exploring data in the data view and want information about a 
particular feature, use the Identify tool, found on the navigation bar shown below. 
 

 
 

o Use the Identify tool to explore the attributes of a 
feature by selecting the tool from the navigation bar and 
then clicking on a feature in the Data View. Note that 
the same attributes from the attribute table show up in 
the pop up window. 
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Part 3. Interacting with your Data and Importing Data – Working with Excel 
 

1. ArcMap is a very robust application. You can interact with your data in many, many different 
ways to analyze, interpret, create, and convey new information. In this section, we will create a 
new geographic dataset from an existing spreadsheet; extract part of a dataset to create a new 
subset, and then we will symbolize and label this dataset in preparation for making a map. 

 
2. If you have anything selected (highlighted) on your map, use the Clear Selection button to the 

left of the black arrow on your toolbar to clear your selection. If this option is grayed out, you 
have nothing selected and need not worry about this step.  

 
 

3. Excel documents (.XLS), Comma Separated Values (CSV) files, and Text (.TXT) files are often 
used to store and analyze structured data. In particular, Excel and CSV files are popular. We will 
use a spreadsheet from the United Nations Population Division to create data and display 
information about cities across the globe and in Peru in a geographic context. 
 

4. In Excel, open the WUP2014-F22-Cities_Over_300K_Annual.xls document in the Workshop 
Exercise 1 folder. 
 

5. Explore the fields included in the dataset and get a sense of the information included: 
o What format is each field in? For instance, is it text, an integer, a decimal, or a year? 
o How many fields are there? 
o How many records are there? 
o Is there anything other than data, such as notes or headings, in the spreadsheet? 

 
6. ArcMap does not like certain characteristics that are often included in spreadsheets and CSVs, 

and we have to ‘polish’ our spreadsheet before importing it or ArcGIS will get angry. This is one 
reason why it is important to be familiar with your dataset. Here are some of the most 
common issues to consider: 

o No spaces allowed in field names. 
o Field names must start with a letter, but can still include numbers 
o The word ‘Year’ cannot be the title of a field. 
o No special characters, such as parentheses, commas, or hyphens. If it is not a letter or 

number, we must take it out of the field name. 
 

7. We will now polish this spreadsheet to bring it into ArcMap. 
a. Use the Save As tool to save a new copy of the spreadsheet in case we make a mistake 

with this one. We can always return to the original. Just Append ‘_ArcGIS’ to the end of 
the filename: 

i. WUP2014-F22-Cities_Over_300K_Annual_ArcGIS.xls 
b. Note that Rows 1 through 16 on the page Annual_Data do not contain data, but do 

contain useful information. Cut and paste these rows into a new spreadsheet in the 
workbook, and then delete the 16 rows from the sheet Annual_Data. 

c. You now have useful headers, but must remove any incompatible characters. Renaming 
headers can be a tenuous process, but there are some tricks that can save you time if 
you know your way around excel. 

d. Let’s get rid of all the spaces in the header rows. We will do this by selecting the header 
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row, then replacing all the spaces with no characters, thus deleting them. This is much 
faster than deleting the spaces individually and manually. 

 
e. Select row 1 by click on the ‘1’ at the far left of the row, as shown below. 

 
 

f. At this point you can either choose ‘Find & Select’ from the ribbon or hit ‘Ctrl + H’ to 
bring up the Find and Replace Dialog, as shown below.  

  
 

g. Type a single space in the ‘Find what’ field, and leave 
the ‘Replace with’ field blank. Click ‘Replace All’ and you 
will see all the spaces in the headers have disappeared. 
It is important to be sure you have just the header row 
selected when performing this operation or you will 
remove ALL THE SPACES in the entire SPREADSHEET. If 
you do this, simply click undo and try it again. 
 

h. Next we will add the word ‘Year’ in front of each of the 
numbered years, since we cannot have a field name 
that begins with a number. To begin, insert a new row 
above row 1 by right clicking the ‘1’ and choosing insert.  
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i. Next type the following formula into the cell above 1950 : =CONCATENATE("Year",I2) 
i. This formula is combining the word in quotations with the contents of the cell 

directly below it, which is I2. It will maintain this relative reference when we 
copy it to a new cell. In other words, it will always pull the value from the cell 
directly below where we put the formula. 

 
ii. Copy and paste this formula into all the cells in the header row from column I 

through CK by dragging the small white box in the corner of the cell all the way 
to the right until you get to CK. 
 

j. Copy the cells you just filled in with the formula, select the corresponding cells below 
them in row 2, right click, and choose ‘Paste Special’ or click the ‘123’ option under 

‘Paste.’ This will paste the value created by the formula (ie Year1950) instead of the 
formula itself. 
 

NOTE: You will know if you paste the formula instead of the values if you see that the year no longer 
makes sense (ie ‘Year82.468’) The correct version is shown below on the left, and the incorrect paste 
is shown on the right. 
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k. Now delete Row 1 and save your Excel Document. 
l. Your spreadsheet is ready for ArcMap! 
 

Return to your ArcMap Document. 
 

8. Using the Add Data button, navigate to your Excel document. Double click your version with 
the ‘_ArcGIS’ appended. It will navigate further into your excel document to show the different 
sheets available. We want the one titled ‘'ANNUAL DATA$'.’ Select this sheet and click Add. 

 
9. You will see that your Table of Contents 

looks a little different. This is a different 
view in your Table of Contents, which 
lists your data by Source rather than by 
drawing order. To see data in tables that 
is not in a layer yet, you must use this 
view. You can hover above the icons at 
the top of your Table of Contents to see 
how each viewing option is used. 

 

10. Next, we are going to use the Latitude 
and Longitude fields in our spreadsheet 
to tell ArcMap how to locate the data in 
our sheet. 

 

a. Right click on the Annual Data 
table and choose Display XY Data 

b. ArcMap makes some assumptions about your data based on the column names, but it’s 
not always correct. If needed, change the X field to Longitude and the Y field to Latitude. 
Leave the Z field empty for this data set, as we do not have any elevation data 
associated with our cities. 

c. ArcGIS defaults to GCS_WGS_1984 for its datum, which is accurate in this case. You can 
change this using the Edit button if needed. 
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d. Click Ok and disregard the error message about the Object ID field. We will remedy this 
soon. 

e. Now you should have a map full of points displaying your cities! 

 
 

 
f. Save your ArcMap document. 
g. Your ‘Annual Data$ Events Layer’ is a temporary layer that ArcMap is showing by reading 

from your excel. Let’s make a permanent Shapefile from this layer, as temporary layers 
have limitations and can be unpredictable. 

h. Right click the 'ANNUAL DATA$' Events layer and navigate to Data-> Export Data. 
i. Ensure you are exporting ‘All Features’ and save your new shapefile to your Lesson 1 

folder with the file name UN_Cities.shp 
j. Choose ‘Yes’ when asked if you want to add this to your map. 
k. Now you have a reference to your shapefile in your map as a new layer - You’ve just 

created a new geographic dataset and mapped it ArcMap!  
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Part 4: Querying, Symbolizing, and Labeling your Data 

 
1. Using the Toolbar at the top of your Table of Contents, switch back to the List by Drawing Order 

view. 
2. Double click on the UN_Cities Layer to bring up the properties dialog and navigate to the 

Symbology Tab. 
3. ArcMap has many symbology options for your data. Explore the options on the left: 

o Features-> Single symbol allows 
you to have all features in a layer 
depicted with the same symbol. 
o Categories option you can use 
an attribute field to differentiate 
between categories of points. For 
instance, a field listing the type of 
city as Country Capital, State 
Capital, or County Capital could 
show each type differently. 
o Quantities allows you to use a 
numeric attribute field to determine 
the symbology. Size and color will 
change for each feature in 
accordance with the value of the attribute for that feature. 
o Charts allows you to depict multiple attribute values in a single symbol, such as a bar or 
pie chart for each feature. 
o Multiple Attributes allows you to create combinations of attributes that, together, are 
their own category. For instance, if you have an attribute for City Type and an attribute for 
Under 5,000 or Over 5,000 people you could depict both attributes in a single symbol by 
having a unique value for Country Capital, Under 5,000 and a unique attribute for Country 
Capital, Over 5,000. This option can be cumbersome if you have too many permutations of 
attribute values, though, so it is best for small lists of types. 
 

4. We are going to use the Quantities option to symbolize the population size for cities in our layer. 
Click on Quantities -> Graduated Symbols. 

We will choose the attribute field of which we want to base our symbology. Click the drop 

down for Value: and select Year2014.  ArcMap automatically suggests how you might group 

your data into ranges using the Natural Breaks (Jenks) method. You can read more about the 

methods for classifying your data in the ArcMap Help. You can also change the color and 

symbol used by clicking on the Template button to the right. For now, let’s simply edit the 

values so that there are no decimal points.  

 
5. Click on the first value listed in the Range column – not the label column. Edit the value so that it is 

an integer. Repeat this for all of the ranges listed until your data looks like the image below. Be sure 
to round up for the last value so that you don’t lose any features. 
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6. Adjust the labels so that there are no redundant zeroes showing. This will transfer to our legend 

later and look much cleaner. Click on the header for the Label column and select Format Labels. In 
the Rounding Box change the number of decimal places to ‘0’ and select okay. Note that we had to 
change both the Range and the Labels so that the Labels accurately reflect the Range values.  

7. Hit Apply, and move the Properties dialog to preview your map.  
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8. At the global scale, this data is somewhat overwhelming and difficult to depict. We are interested in 

cities in Peru, so click OK and zoom in to explore Peru.  

Reminder: Use the magnifying glass to zoom in, and then switch back to the black arrow. 
Insider Tip:  Use the selector tool on your navigation bar to click and select Peru.  

o Right click and choose Zoom to Selected Features. Make a Bookmark for Peru by going to the 
Bookmarks Menu and selecting Create Bookmark. Name the bookmark Peru. This will allow 
you to quickly navigate to this map extent again in the future. If you have Peru selected, be sure 
to clear your selection using either the clear selected features tool on either your toolbar or 
Selection Menu.  

Your Data View should look like this now:  
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9. Since we are only interested in Peruvian cities, let’s extract this from our current dataset and create 
a new subset of Peruvian cities. There are many ways to accomplish this, but this time we are going 
to use the Select by Attribute tool to select all cities that have Peru listed as the country.  
o Open your UN_Cities attribute table by right clicking on your UN_Cities layer and selecting Open 

Attribute Table. You can see all the attributes transferred from the Excel document we started 
with. Familiarize yourself with fields.  

o In the Selection Menu choose the Select by Attributes tool. This is also accessible through the 
attribute table in the upper left corner. 

o Be sure that the ‘Layer:’ field is set to UN_Cities, as this is the layer we want to query. We are 
creating a new selection, so ensure the Method says ‘Create a new selection.’  
▪ This option can be used to create a query which selects within, adds to, or removes from an 

existing selection.  
o Build your query statement. We want to return values that match the thought Country is Peru, 

so: 
o Double click the field ‘Countryora’ to add 

the country attribute to your query.  Single 
click the = button to add it to your query 
statement:  = is the ‘is’ in your query 
statement. Click the Get Unique Values 
button to retrieve and list all the options in 
the ‘Countryora’ field. Type Peru in the Go 
To: field to quickly find Peru. Double click 
Peru to add it to your query statement.  

o Verify your query to be sure we made no 
syntax mistakes by clicking the Verify 
button. If there are errors, clear the 
statement and try again. If not, click OK in 
the verify dialog and Apply in the Select By 
Attributes tool.  

o Note that ArcMap selects your cities in the 
Data View and that they are also selected in 
the attribute table. 
 
 
 
 

10. We are going to export these cities to a new layer in ArcMap to more easily work with them. This 
will not create a new shapefile, just a layer reading only cities that match our selection from the 
UN_Cities shapefile.  
o Right click the UN_Cities layer, go to Selection, and choose Create layer from selected features. 
o Turn off the original UN_Cities layer and the 'ANNUAL DATA$' Events layer clicking the check 

box next to each, and see that only the cities in Peru, which we selected, are showing on the 
map. 
 

11. Change the symbology for your new layer to a quantities type that you like and adjust the range 
and labels to integers with no decimals showing. 
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12. Now let’s label the cities in our map. In the properties dialog, go to the labeling tab. You can 
choose to pull labels for each feature from any attribute field. We are going to show the names of 
the cities, but you could also show the population or a combination of attributes using an 
expression. 
In the Label Field drop down, ensure that UrbanAgglo is selected. You can use the options in the 
Text Symbol section to adjust the font, size, and color for your text, as well as more advanced 
options using the Symbol button. For now, select a size 14 Arial Black font and click OK.  
o Enable labeling for your cities layer by right clicking the layer and choosing label features.  

 
Congratulations! You’ve created a map of cities in Peru based on their population size. Let’s make a 
finished map product using the layout view next. 

 
Part 5: Creating a Layout 
 

1. Select View/Layout View. You may need to resize/reorient the Layout to accommodate the 
orientation of the geography of the surface you are mapping. There is a separate toolbar for 
navigating your layout view than for navigating the geography of your data. 

 
MAP ELEMENTS: 
Be sure to add all the map elements: North arrow, legend, 
title, source, scale, date, author by using the Insert option on 
the Menu bar. Think about sizing of elements, spacing, white 
space on the page, etc. These elements should be on ALL 
future maps. 

 
o A title should include three things: Theme, year of the 

theme, and geography. Be sure you are in Layout View. 
 

● From the Insert menu, select Text. 
● Type a meaningful Title with the date & 

geographic area then click OK.  
● Move the title box above the map data. 
● To change the font, right click the title box. 
● Select Properties. 
● Select Change Symbol. You can change the font type, size and style. 

 

Title fonts should be bold and 16‐point or higher. Try a font of 36 point, choose one 
font type for all the text on your map. Sans serif fonts (i.e., Arial or Helvetica) are 
easier to read than serif fonts. 

 
‐Click OK to close the windows. 
‐One quick way to get the right title size is to use the Fit 
Width to Margins option: Right click the title, select 
Distribute, and then Fit Width to Margins. You still may have 
to adjust the size of the title. 
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o A legend and symbology tell the story of your map.  

Insert legend ‐-From the Insert menu, select Legend. 
‐Click Next, then Next again to accept the defaults. 
‐On the Legend Frame wizard, select a 0.5 border for the first option. For the Background 
color, select White. The default for a legend is Hollow, which makes the Legend 
transparent. 
‐Click through the rest of the wizard and Finish. 
‐Move the legend to a spot close to the data frame – this is usually a good place for a legend. 

 
NOTE: When creating maps with multiple layers, the legend should be organized logically with the 
key data layers above base data layers. 
 
o Insert Scale Bar  

Scale bars should accompany every map since scale is a critical element for 
distance/context.  
‐From the Insert menu, select Scale Bar.  
‐Select the first scale bar template by clicking on it once, then select Properties.  
‐Change Division units to Kilometers.  
‐Click OK to close the windows.  
 

o Insert North Arrow  
With north arrows, the simpler the better. Avoid overly ornate arrows, yet find your style.  
‐From the Insert menu, select North Arrow. Often the North Arrow will be positioned adjacent to 
the Scale Bar.  
 

o Insert source 

Be sure to include the sources for data and maps. Citing data sources helps the reader verify the 
primary source of data. There are many ways to cite sources. Be sure to be consistent in how you 
cite sources: 

‐Create a text box for the source information. On the Insert menu, select Text.  
‐Drag the text box to the lower right corner to be able to see it. 
‐Right click the text box and select Properties. 

 
You may have two parts to your source: the Map Source and the Data Source: 

Map Source: Your organization (or your name), date 
Data Source: where the data was obtained from ‐Add the 
production date of the map. 

 

 

 
 
 
‐Click OK. 
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o Map frame boundary (optional). Also known as the Neat Line  

A simple frame is best – use the default (simple) and a width of 0.5.  
 

‐While in Layout View, click the map frame to activate it. Blue dots will appear around 
the frame.  
‐Right‐click the map and select Properties.  
‐Select Frame tab  
‐Under Border, scroll to the top and select a style.  
‐Click OK.  

 

NOTE: The design and organization of the map should be well‐balanced. Avoid clustering 
the elements on one side of the map, avoid overly large fonts for the title and legend, and 
white space should be fairly equal on all sides of the map.  
 

Challenge Activity:  Use the UN Population data to make a map of population in another part of thew 

world.  Create a layout. 


